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Preface

This manual describes how to create and maintain your own Palace Personal Server for 
Macintosh. It explains how to obtain the software, setup, launch, and customize the 
server, and maintain your Palace site.

Sections of this manual
This manual has the following sections:

• Introduction

This section introduces the Palace community and Palace personal server software.

• Getting Started

This section guides you through installing and settup up your Palace server.

• Administering Your Server (Wizard and God Mode)

This section explains the Palace wizard and god modes, and how to enable them 
on your server.

• The Palace Server Interface

This section describes your Palace server graphical interface.

• Iptscrae

This section briefly describes the Palace Iptscrae Language, and how to get more 
information on it.

In addition, there is an appendix about the Palace Client Plugin API.

Manual conventions
This manual has the following conventions:

• Code samples and text you enter are set in Courier , whether standing alone or 
embedded in the text.

• Technical terms appear in boldface italic in the text in their first appearance, 
usually accompanied by a definition. 

• Graphical User Interface (GUI) elements, such as menu items and buttons, appear 
in boldface.

• References to other books, chapters, or sections are in Italic.

NOTE – Notes to the user look like this.
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Other sources of information
Besides this Personal Server for Macintosh Guide, the Palace provides other online 
manuals; these are all available from the Palace website. The following manuals are 
especially useful:

• User's Guide. This manual describes how to use obtain, setup, and use the Palace 
client software. You will need the Palace client to perform wizard actions for your 
site. Both a Windows and Macintosh version are available.

• Wizard's Guide. Describes the responsibilities of a wizard, and details the Palace 
client's wizard interface and commands.

• Iptscrae Language Guide. This manual is a programming and language reference 
guide for the Palace Iptscrae language.

In addition to the Palace online manuals, check out these pages in the Palace website 
for support, information, and online documentation:

Palace Home Page:

http://www.thepalace.com 

Palace Sites Listings:

http://www.thepalace.com/welcome/sites/index.html

Palace FAQ:

http://www.thepalace.com/support/faqs/index.html

Palace Downloads (software & Assets):

http://www.thepalace.com/downloads/index.html

Palace Documents (Manuals):

http://www.thepalace.com/support/manuals/index.html

Palace Tech Support:

http://www.thepalace.com/support/
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1 Introduction

Welcome to the Palace! The Palace technology provides software and tools that let web 
developers add graphical chat and event capabilities to existing Websites. But more 
than that, the Palace also is a diverse online world of communities that you can explore 
to socialize, learn from, and exchange ideas with other users. 

Using the Palace Personal Server software, you can create your own Palace site. This 
site is your own personal graphical chat environment that can host at least eight users 
(according to your license). Setting up a Palace site is quick and easy. In fact, you can 
create your own custom Palace in minutes, using standard room art or even importing 
your own. You then can customize your site as much as you want with different rooms, 
artwork, and even executable scripts.

To customize your server, you can create artwork for new rooms, create a custom site 
from these room background images, and then add scripts that execute when people 
enter these rooms.  When you get to be a more advanced operator, you can then learn 
an endless number of advanced interactive tricks and shortcuts with Iptscrae , the 
programming language that comes with the Palace software.

This manual documents how to set up your own Palace personal server. For 
information on the Palace and how to use its interface, see The Palace User Guide.

The Palace community has three types of users:

• Palace gods are the superusers of their Palace servers. By default, you are a god of 
your own Palace, and can give this capability to others. Your role as the god 
superuser includes creating, maintaining, running and evolving your Palace Site. 
Palace gods possess a special set of commands, which are fully documented in the 
Palace Wizard's Guide. You execute god commands through your Palace client 
while connected to your server. To do this, you establish a god password for the 
client.

• Palace wizards are “power users” who have been entrusted with special powers 
and responsibilities on one or another Palace Server (including their own). They 
have the ability to create and destroy rooms, alter room-level Scripts, ban unruly 
users, and generally run the place. Some wizards lean more toward the design 
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angle of the job, concentrating on creating new rooms and room-level Scripts, 
while others prefer the social angle, and spend their time hanging out in the Palace, 
keeping things moving, interesting, and within community standards.

Like god capabilities, wizard capabilities are enabled on the Palace client through a 
wizard password you establish for your site. You can let others be wizards by 
giving them this wizard password. Wizard capability is described in more detail in 
the Palace Wizards Guide.

• Users are the people who visit your and other Palace sites using the Palace client 
software. You can and should install the Palace client software (available from the 
Palace web site) to become a user of the Palace community. In fact, you need to use 
the Palace client to access other Palace sites, and also access wizard and god 
capabilities.
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2 Getting Started

This section describes everything you need to know in order to get your server online:

• Requirements on page 9

• Installing the Palace Personal Server on page 10

• Getting your server up and running on page 11

Requirements

The Palace Server for Macintosh has the following requirements:

RAM: At least 3 megabytes. If you intend to run Palace server and the Palace Client on 
the same machine, you will need 5 megabytes of free memory.

Disk Space: You will need around 2 megabytes of disk space to download the Palace 
server. The files associated with running the Palace Server will require about 500 
kilobytes (half a meg) of free hard disk space (this is in addition to the two megabytes 
worth of pictures you’ve probably already installed).

The only file that will grow noticeably in size is your Pserver.prp file. Beginning at 
around 300 kilobytes, this file stores the binary data associated with all props used in 
your Palace by all members. This can get to be quite a large file if your site becomes 
popular; it’s not uncommon to hear of 10- or 20-meg prop files. There are two ways to 
control the size of this file:

• Use the `purgeprops or `flushprops  command. Purge deletes all loose props 
older than the specified number of days, regardless of which room they are in. 
Flushprops also deletes all loose props older than a specified number of days, but 
compresses the prop file when it’s done. This sacrifices prop “performance speed” 
in favor of compact file size. 
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• Make a backup copy of your pserver.prp  file, while it contains only those props 
you want it to contain. Periodically thereafter, you may overwrite your current 
propfile with the backup version. However, do not copy the prop file while the 
server is running. This can crash the server, corrupting the prop file and negating 
any changes you have made in authoring mode.

Hardware: Color Macintosh with System 7.

Installing the Palace Personal Server

The Palace installation includes these files:

• server application (Pserver )

• prop file (Pserver.prp )

• script file (Mansion Script )

• preferences file (Pserver.prf ). 

To download the installation file, select it from the Palace website’s Download page. 
After the download file is copied to your machine, click on it to start installation.

▼ To install 

1. Go to the downloads  page of the Palace web site (www.thepalace.com).

2. Register for your software by clicking the registration link.

3. After you register, click the server download link for the Macintosh.

4. The installation file is downloaded to your desktop. To install it, click the file’s 
icon.

5. During the installation program, follow the directions onscreen. 

6. You can select Easy Install to have the standard full installation, or Custom Install 
to install the server files.

NOTE – You should regularly make backup copies of your Mansion Script  and 
Pserver.prp  files: these files maintain the state of your rooms and all the things in 
them.
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Getting your server up and running 

After you install
After you install and set up your Palace server, you should establish your god and 
wizard passwords immediately. Changing these passwords will maintain the security 
of your Palace by preventing any user from obtaining god and wizard capabilities to 
your site without your permission.

To change your passwords, use the Server Preferences window (see The Edit Menu on 
page 21).

Getting your server up and running

Once you have installed the Palace, you can go ahead and launch and customize your 
Palace server. 

Launching your Palace server
On your machine, click the PServer icon in your Palace root folder (by default, The 

Palace ). You access the server interface window:

For detailed information on using this interface, see The Palace Server Interface on page 
19.

Connecting to your Palace server 
You connect to your Palace server through your Palace client. You must install the 
Palace client software before you can do this. To obtain the Palace client, go to the The 
Downloads page of the Palace web site.
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You can connect from a client either on your own machine (the same Macintosh 
machine hosting your server) or a remote machine (which could be either a Macintosh 
or Windows 95/NT machine)

▼ To connect locally

1. Start your server.

2. Start your Palace client by clicking on the Palace icon in your Palace client 
installation directory.

3. Select Connect... from the client’s File menu.

4. In the resulting connection window, enter one of the following:

• To connect without having to go through an Internet Service Provider (ISP), 
enter localhost . This is the Palace local host address.

Or

• If you are on a LAN, or going through an ISP, you can enter your machine's 
name or IP address, and port number. Generally, you can use the default port 
of 9998.

▼ To connect remotely

To connect remotely, follow the instructions for your specific client. This example 
demonstrates connecting from a remote Macintosh client machine.

1. Start your Palace server.

2. Start your Palace client by clicking on the Palace icon on your desktop.

3. Select Connect... from the client’s File menu.

4. In the resulting connection window, enter your server machine's address in the 
format machine.domain ; for example, test.communities.com.  You can also enter 
the machine's IP address (such as 205.999.99.99 ). Or, select your server from the 
dropdown list; it will appear there if you have previously connected to it.

▼ To connect remotely using AppleTalk

If your client is on a remote Macintosh machine connected through AppleTalk, use 
these steps.

1. Start your Palace client by clicking on the Palace icon on your desktop.

2. Select Connect Via AppleTalk from the File Menu.
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3. A dialog box displays listing the computers on the AppleTalk network that are 
currently running the PalaceServer (your own computer will be listed here as well, 
even if it isn't running the server). Select the computer you want to connect to, then 
select Pserver and click OK.

Making your Palace site accessible to others
Users can connect to your site when you have it up and running. There are multiple 
ways users can access your site; these are all documented in the Palace User's Guide.

By default, your Palace site is listed in the Palace Directory list every time you start 
your server. The Palace Directory list resides on the Palace website, and is a list of all 
currently-running Palaces. If you don't want your Palace site to be listed here, take it 
off the Directory list by de-selecting Show this server on the directory web page in 
your server's Palace Directory Information window (select Edit:Palace Directory to 
access this window). If you do decide to make your Palace available on the A-Z list, be 
sure to give it a good description and also fill out the Palace Directory description form 
on the Palace website.

You can also give users your machine address (in the format machine.domain,  such as 
test.communities.com)  or IP address (such as 205.999.99.99 ) so they can access it 
directly without having to search for it on the Directory list. They can enter this name 
or address in either their Palace client connection window or their web browser. Once 
they have visited your site, they can return to it by selecting it from their list of 
previously-visited Palaces in their connection window.

You can even give Palace users access to specific rooms in your Palace server through 
URLs. To give somebody room access, you give him or her your Palace server address, 
port number, and the room ID (from your Palace client's Wizard menu, select Room 
Info on a specific room to find the ID). Users can then enter this URL in their web 
browser. You can also include this reference in one of your Palace site rooms as a "hot 
spot" link. Note that users cannot access a URL-addressable room through their Palace 
client connection window.

This example illustrates the extended URL specification, where 89 is the room ID on 
the Palace server located at mansion.thepalace.com  (port 9997). 

NOTE – If you don't provide a port, the Palace client always assumes port 9998. 

Windows client version:

palace://mansion.thepalace.com/89:9997

Macintosh client version:

palace://mansion.thepalace.com:9997/89

To include a room reference in your web page, use the HTML <a href>  command. To 
include a room reference as a hotspot in a Palace room, use the Netgoto  command. See 
The Iptscrae Language Guide for more information on the Netgoto  command.
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Changing the look of your Palace site
You can change the look of your Palace by customizing and adding rooms. These 
rooms can be linked together, have original artwork, and scripts that execute when 
users enter the rooms. You create your room artwork first. Then, add the new artwork 
one room at a time through the Palace client's wizard capability.

Creating the room artwork

Each room in your Palace corresponds to a graphics file (GIF file). You can use 
background images from anywhere; but they must meet the following requirements:

• 512x384 pixels.

• 256 color GIF. You can use a bitmap image if you are using the Palace Authoring 
Wizard (available free from the Palace website); this tool automatically converts 
your bitmap to a GIF.

• Conform to the Palace Palette color scheme. To ensure this, download the Palace 
Palette from the Palace website, open your image in a graphics editing tool (such 
as JASC PaintShop Pro or Adobe Photoshop), and load the Palace palette according 
to your graphic tool's instructions. You can also open a Palace image in your 
graphics editor and save the Palace Palette from that image, again according to 
your graphic tool's instructions. 

Once you have the palette source, open your image file in the graphics editor and 
convert it to 8 bit/256 color, loading the Palace Palette to convert the image to the 
Palace color scheme.

When you have your room artwork ready, you can customize your site with these new 
background images either through your Palace client's wizard mode, or by directly 
editing your pserver.dat  file. 

NOTE – Editing the pserver.dat file is for experienced users only, and is not 
documented in this guide.

Using Palace client wizard mode

If you create your own graphics files for rooms, you can add them through wizard 
capability on your Palace client. The following steps describe using wizard mode from 
a Macintosh client.

1. Create a wizard password and god password on your Palace personal server. To do 
this, select Preferences from the server's Edit menu. From the resulting Palace 
Server Preferences window, click Wizard and God to set passwords for these 
capabilities.

2. Log on to your Palace client software and connect to your personal server using 
the previous instructions in Connecting to your Palace server on page 11.
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3. To enable wizard capability, select Wizard from the client's Options menu. You 
must enter the wizard password.

4. When wizard capability is enabled, you will see the Wizard menu. Use the options 
on this menu to create and link rooms. Here is a summary of what to do; for 
detailed information on these Wizard menu items, see the Palace Wizard's Guide.

a. Use the New Room option to create a new room on the server.

b. Use the Wizard menu’s Room Info option to bring up the Room Info window. 
From this window, enter a name for the room, attach your graphics file in the 
Pict field (click Pict to browse for it if necessary), and set options for the room. 

c. Enter authoring mode by selecting Authoring Mode from the Wizard menu. 
Now, instead of activating doors and rooms, you can edit them when clicking 
on them.

d. Use the Wizard menu’s New Door option to add a door to this room. Then, 
select the door and use the Door Info option to set options for this door, such 
as its destination, and add a script. Doors that execute scripts, such as 
connecting to other Palaces or activating web pages, are called Spots. You need 
to change this door type from Passage to Normal.

Stopping your Palace personal server
You might need to stop your Palace server periodically for maintenance.

▼ To stop a server on a local machine
Select Quit from the File menu.

▼ To stop your Palace personal server remotely 

1. Connect to your Palace personal server from your Palace client.

2. Select Wizard Mode (or Wizard for Macintosh) from the Options menu, and enter 
your god password to enter god mode.

3. Type the god command `shutdown in your client input window, and press the 
Enter/Return key.
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3 Administering the Server 
(Wizard and God Mode)

This section describes how to administer your server using wizard and god mode.

What are wizards and gods?

Now that you have set up your Palace Personal Server, you can administer it online. 
For example, you might want to:

• Write scripts, add or modify rooms and test out your changes

• Do crowd control or enforce behavior standards

You can do this by going into wizard or god mode from the Palace client software. 
Wizards and gods both have their own set of commands to help them perform their 
functions. Wizard mode enables you to do things such as change room graphics, add 
scripting, and remove unruly visitors. The god mode enables you to do everything a 
wizard can do and regulate how much authority your wizards have. Commands for 
gods are more powerful than wizard commands. Wizard and god commands and 
capabilities are discussed in detail in the Palace Wizard's Guide, available from the 
Palace website.

You enable wizard and god capabilities on your server through passwords entered on 
the Palace client. To establish your wizard and god passwords on your server, select 
Preferences from your server’s Edit menu. On the resulting preferences window, click 
Wizard or God to set the respective passwords. You can give these passwords to others 
if you wish.

You can change these passwords as required. You can also change them remotely with 
the following steps:

1. Connect to your Palace personal server using a Palace client.

2. Enter god mode using your current god password.
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3. Enter the god new password with the following syntax:

 'godpass <new password>

4. To change the wizard password, type:

 'wizpass <new password> 

To enter either wizard or god mode on your client, select Wizard Mode (or Wizard for 
Macintosh clients) from your Palace client's Options menu. In the resulting password 
dialog, enter the wizard or god password. Wizard Mode remains in effect until:

• You turn it off,

• You disconnect from the current server, or

• A local god turns the Wizards Permission off.

NOTE – Your wizard status is not saved anywhere on the server. If you want to use 
wizard or god powers next time you sign on, you will have to enter the Password 
again. This is a security feature; it keeps others who use your Client from automatically 
becoming wizards themselves.

Your godhood remains in effect until:

• You turn Wizard Mode off, or

• You disconnect from the current server.
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4 The Palace Server 
Interface

This section describes the Palace server interface:

• Overview of the interface on page 19

• The File menu on page 20

• The Edit Menu on page 21

Overview of the interface

The Palace Server has an extremely simple and straightforward interface, as shown 
below. This is fitting, since you won’t spend much time interfacing directly with this 
program. The server interface is used primarily to open your site and register it with 
the Palace Directory; after that the server remains quietly busy in the background.

The Palace Server Interface
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The server interface consist of two simple parts: a large scrolling textbox and a menu 
bar. The textbox displays important information regarding the operation of the server, 
the network, and all users currently logged on; you cannot type into this textbox. The 
following sections explain the use of the various menus.

The File menu

The File menu contains commands which are related to the maintenance of server 
records. The Quit command is also found here.

Open

Close 

Save

Start|Stop Log...

This option toggles the log file window open or closed. Enter the name of the log file 
you wish to create (a date-based default name is provided).

NOTE – The Log kept by the server is not the same as the Log kept by the client; it 
records only the network-level information which appears in the large scrolling text 
area of the server interface; not room-level activity or speech (such as appears in the 
client Log Window).

User list

This menu command displays the server’s User List window, which lists users 
connected to your server.

Create User Log File

This menu command allows you to output a textfile called Userdata.lis,  which 
contains basic information on all users who logged on to your server during the last 
run. This information includes the userID  number, Last Nickname Used , Last IP 

Address , Last On Date , and other information for very user on the server.

Registration...

This menu command displays the Registration Dialog Box, containing fields for you 
to enter your name, organization, and server registration code. Use this window to 
register your Palace server. Your registration code is used (among other things) to 
determine how many simultaneous users may connect to your server at one time. After 
you enter your information, click Register.

You use this window to update your server license; just enter the new code in the 
Registration Number field.
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Quit

This menu command shuts the server down and closes the program.

The Edit Menu

The Edit Menu contains all the typical editing commands (such as cut, paste, etc.), and 
provides access to the server’s preferences window.

Undo

Cut

The hotkey combination for this command is Command-X.

Copy

This command allows you to copy selected text from the textbox. The hotkey 
combination for this command is Command-C.

Paste

The hotkey combination for this command is Command-V.

Clear

This command clears the contents of the textbox.

Select all

Preferences

This option displays the Palace Preferences window, which lets you set options to 
customize your server.
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This window has the following fields and buttons. To have the server accept your 
values, click Set. 

You can also click the lock icon to password-protect your server preferences, 
preventing others from tampering with your settings while you are away.

• Server Name

This is the name of your Palace. When users log on to your server, the Server Name 
is added to their list of recently-visited Palaces (this list is automatically compiled 
by the client). It is also used to register with the Palace Directory server (see Palace 
Directory on page 27). In addition, the Server Name is used to create a folder on 
your users’ machines in which your sounds and pictures are stored (this folder will 
be called :Palace:Media:serverName:  ). If you change your Server Name after 
going online, your users will have to rename this file or re-download all of your 
assets.

• Maximum Server Occupancy

Allows you to set the maximum number of people who will be allowed to log into 
your Palace at one time. After this limit has been reached, anyone attempting to log 
in will receive a "Connection Refused" message. 

NOTE – This number may be no greater than the maximum number of users allowed 
by the terms of your server license.
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• Maximum Room Occupancy

Allows you to set the maximum number of people who will be allowed to enter 
any one of your Palace rooms at one time. This server-wide setting may be 
overridden by the “local” occupancy limit of the room in question (as specified in 
the Room Info Dialog Box— see The Palace Macintosh User’s Guide). After this limit 
has been reached, anyone attempting to enter a filled room will receive a message 
saying "Sorry, the room is full."

• Text File Creator

This box displays the four-letter code associated with the word-processing 
program used to edit the Mansion script (this is known as the “Creator” program, 
and it is the same as the program indicated by name in the Progr... field. When you 
enter a valid Creator code in this box, the full name of the corresponding program 
will appear in the Program box. If you don’t know the four-letter code for the 
Creator you want, use the Program control to select one.

• Progr

This dropdown menu allows you to select a word processing program (“prog”) for 
editing the Mansion script. When you select a program here, the four-letter code 
associated with that program will appear in the Text File Creator box (see above).

NOTE – You can edit the Mansion Script with any word processor which will read and 
write ASCII (“Text Only”) files. However, word processors tend to handle hard and 
soft carriage returns differently, and this sometimes causes null characters to be 
inserted into your script; especially when sharing scripts across platforms (with 
Windows or UNIX users).

• Font

This control allows you to specify the font for all text which appears within the 
View Screen: cartoon balloons, User Names and hotspot names.

NOTE – This font is only seen by other Macintosh users. Windows users will see their 
own fonts.

• Size

This control allows you to specify the point size of the text displayed for all 
balloons, user names and hotspot names. This effect is only seen by other 
Macintosh users.

• Pictures Folder

This control allows you to specify the folder in which your Palace PICTs are kept. 
The Macintosh server expects the syntax to follow the standard format in which 
the folder name is bookended by colons; for example:

: Pictures :

The Windows and UNIX servers, on the other hand, are looking for slashes:
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pictures/

NOTE – Cross-platform developers: The data entered here will show up in the “server 
Prefs” section of your script file. The command is called PICFOLDER: and the folder 
name itself is in doublequotes. The format used for the folder name must match the 
expectations of the machine the server will run on, no matter what type of machine is 
used to edit the script file. If the server will be on a Mac, the colon format must be 
used. If the server will be on a PC, the slash format must be used. This is the only item 
in the script file which is not cross-platform, and will be addressed in subsequent 
versions.

• Wizard Password

Wizards may use the authoring features of the software and execute special wizard 
commands; they’re pretty powerful folks. Clicking here brings up a dialog box 
allowing you to set a password which allows others to gain wizard-level access to 
your server. Since possession of your wizard password implies that you gave it to 
them, these individuals are referred to as your wizards (i.e., the password for your 
Palace does nothing in other Palaces). Don't give this password to anyone unless 
you have good reason to trust them! If you don't want anyone to have wizard-level 
access, simply leave the password entry blank (or delete it). If the security of this 
password is compromised, change it as soon as possible.

• God Password

This option allows you to set the password which grants god-level access via the 
client software. Gods are like wizards, but even more powerful. In addition to 
authoring, gods are able to permanently kick people off the system, enter locked 
rooms, and perform other miraculous acts by using special god commands.

Normally, the only person who should have god access is you, the Server Operator. 
Your godhood is automatically recognized by the server software — you are 
performing god-level commands whenever you change Preferences and 
Permissions, for example — but it is unknown to the client until you enter the 
password (in the Wizard Mode dialog box). If you don't want anyone to have god-
level access via the client software, simply leave the password box blank (or delete 
it).

NOTE – Regarding passwords: High-level access should not be taken lightly. Just as 
with wizard-level access, someone with god-level access has the power to permanently 
ban users (or annoy them away) from your server; your gods and wizards can 
potentially do bad things to your site and your data. If you don't want anyone to have 
high-level access, leave the password entries blank. If security is compromised, change 
your passwords. Most of all: don’t give special access to anyone unless you implicitly 
trust their intentions and capabilities!

• Network... 

Clicking on this button brings up the Network Preferences dialog, which includes 
two options for network access:
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• Allow TCP Connections

This checkbox allows your server to accept connections via the Internet. Leave 
it unchecked if you don't plan to offer Internet connections. It must be checked 
to allow Internet connections.

• TCP Port

Lists your server’s port.

• Allow AppleTalk Connections

This checkbox lets your server accept connections over your local Appletalk or 
EtherTalk network. If it is unchecked, local users won't be able to connect.

• Permissions

Permissions are like site-wide “switches” which can be set to ON or OFF, allowing 
or disallowing various sorts of activity and events. Clicking on this button brings 
up the Server Permissions window:

This window has the following fields. Click Set to accept your field values.

• Allow Guests (Demo Users) to Sign On

When checked, this option allows unregistered Palace users (“Guests”) to 
connect to your server. If not, unregistered connections are refused. 

• Allow Cyborgs & Bots

When checked, this option allows members to run their own scripts (via 
CYBORG.IPT) while logged into your server. For more information on 
CYBORG.IPT and its uses, see The Palace User’s Guide and The Iptscrae Language 
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Reference on The Palace website. Since many members of the Palace community 
have gone to great lengths to develop creative and practical scripts, it is 
generally considered better to disable scripts on a room-by-room basis.

• Allow Painting 

When checked, this option allows members to use their Painting Tools while on 
the server. Painting can cause lag on busy servers, so many gods decide to turn 
it off altogether or to disable it in all but a few rooms.

• Allow Custom Props

When this option is checked, members can wear (and leave behind) their own 
props. If off, such props are not allowed on the server.

• Allow Wizards

This option determines whether or not the Wizard Password will be accepted 
by the server. When checked, everything works as explained in this manual. 
When unchecked, your wizards will be unable to access their Wizard Menus or 
perform wizard commands while on your server.

• Wizards May Kill

This option determines whether or not the ~kill command functions on 
your server. When checked, your wizards can boot users off the server. For 
more information, see the Palace Wizard’s Guide.

• Wizards May Author

This option determines whether or not wizards can access Authoring Mode 
while on your server. If checked, your wizards can add, delete or change 
rooms, doors and spots, and may edit the scripts associated with these 
elements.

• Players May Kill

This option determines whether or not the `kill  command functions when 
issued by a member on your server. If this option is checked, any member can 
boot another user off the server with the use of this command, and the Kill  
button in the Find User Dialog Box is enabled for all members. 

Since this function is of real value in only a small minority of Palace sites, in 
general this option should remain off. For information, see The Iptscrae Language 
Reference on The Palace website.

• Cyborgs May Kill

This option determines whether or not the `kill  command functions when 
issued by any user on your server. If this option is checked, any user can boot 
another user off the server with the use of this command, and the “Kill” button 
in the Find User Dialog Box is enabled for all users. Note the difference 
between this command and the previous one is that this version applies to all 
users, regardless of guest/member status. Since this function is of real value in 
only a small minority of Palace sites, in general this option should remain off. 
For information, see The Iptscrae Language Reference on The Palace website.
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• Death Penalty is xx Minutes

This option allows you to set the number of minutes “killed” users will be 
unable to log into your Palace again.

• Purge Inactive Props after xx Days

This option allows you to set the number of days a prop may sit idle (i.e., 
neither picked up nor moved by a script) before being automatically discarded. 
This is really useful to avoid a messy, cluttered Palace.

• Kill Flooders after xx Flooded Events

This control allows you to set your server's sensitivity to flooding, in terms of 
events per second. A flooder is a user who mistakenly or maliciously runs a 
looping or overly-complex script on the server, causing the server to be 
"flooded" with a rapid sequence of commands. This type of activity can cause 
serious lag and affect the experience of all users on the server. If the server 
detects more than “xx” events per second, the user responsible for the flood 
will be automatically disconnected, and will be unable to connect for a number 
of minutes equal to the server’s Death Penalty).

• Disallow use of @x,y (Spoofing)

The @x,y<message> function allows users to “throw their voices,” making 
their cartoon balloons appear anywhere on the screen.  “Spoofing,” as this is 
called, can be a major cause of disruption, and is disallowed at many 
commercial sites.

• Allow Member-created Rooms

This option, when checked, allows members to create their own "member 
rooms" in your Palace. These member rooms delete themselves automatically 
as soon as (A) there's no one in them and (B) their owners log off. All member 
rooms are deleted when the server is shut down.

• Palace Directory

Select this menu option to display the Palace Directory Information window. The 
Palace Directory is an online listing of active Palace Servers, which is maintained 
automatically by the Palace Inc. This feature allows users to locate your Palace 
quickly and easily via the World Wide Web. Your server is publicly available to 
users through the Directory list by default; however, this is optional.
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NOTE – Registering with the Directory is optional; you are under no obligation to 
make the existence of your Palace general knowledge. 

The Palace Directory Dialog Box

This dialog has the following fields:

• Server Name

This is the name of your Palace. When users log on to your server, the server name 
is added to their list of recently-visited Palaces (this list is automatically compiled 
by the client). This is also the name that appears on the Palace Directory if you 
make your site publicly available there. In addition, the server name is used to 
create a folder on your users’ machines in which your sounds and pictures are 
stored (this folder will be called \ Palace root \ Media \ serverName \ ). If you 
change your server name after going online, your users will have to rename this 
file or re-download all of your assets.

• Operator

You can enter your own name here, or the name of the system operator who runs 
your Palace site on a day-to-day basis. This is optional.

• Your Description

If desired, enter a description of your Palace that is listed on the Palace Directory 
A-Z list. This is optional, but definitely recommended if you make your site 
publicly available there.

• Announcement

Enter an optional announcement statement that appears in the Directory listing for 
your Palace. This statement is used primarily for informing potential users of 
current or upcoming events on your site. For example: Featuring Palace Chess 

Tournaments every Thursday at 8PM PST . 
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• Show this server on the directory web page

If this option is checked, your Palace site is listed publicly on the Palace Directory 
list on the Palace web site. If you do not want the existence of your Palace to be 
common knowledge, leave this box unchecked.

Note that the Palace Directory is updated automatically, about every twenty minutes. 
This means that if your site comes up only periodically, within twenty minutes the list 
will be updated to indicate your current status. Likewise, when your site goes down 
(whether this occurs on a regular basis or not), within twenty minutes your entry will 
disappear from the Directory Page.
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5 Iptscrae

You do not have to create complex interactive systems to keep a good Palace going. It 
is quite possible to create and run a popular Palace Site using no more than the 
information presented thus far, without getting any deeper than creating some 
background pictures and building a few Doors. Much of the time, after all, your users 
are really entertaining each other. All they ask of you is a cool environment to do it in. 
And yes — if you build it, they will come.

That said…

It may not be necessary to devise complex interactive elements for your Palace, but it is 
certainly possible, and some Palace Operators find it a goal worth shooting for. With a 
little work, blinking lights, rolling dice, slamming Doors, flying objects, sound effects, 
spoofs, and unseen forces of all kinds can be created with Iptscrae, the Palace’s built-in 
programming language.

To learn how to add such advanced elements to your Palace, see The Iptscrae Language 
Guide available online at the Palace web site.
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 A The Palace Client 
Plugin API

The Palace has an open architecture that makes it possible for other programs, such as 
games, to plug-in. If you're interested in joining the developer's program, please 
contact Electric Communities at the following address:

Matthew Burgess  
Manager, Business Development & Developer Relations
Electric Communities
10101 N. De Anza Blvd, Suite 100
Cupertino, CA 95014

email: matthew@communities.com
408-342-9520 
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